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Introduction 

In this document you will find instructions on how to access and complete your online 

exams. 

Students are responsible for ensuring that their answer sheets are legible, including 

any pictures, diagrams, graphs or other content. 

If you have questions that are not addressed in this document, please visit the Covid-19 

Exams webpage or view the Frequently Asked Questions. 

 

Mock Exam Practice Course 

We have set up a Mock Exam Practice Course in Moodle, where you can practise 

accessing online exams, including viewing exam papers and additional materials, 

downloading answer sheet templates and submitting answers. You will need to enrol 

yourself on the course to participate by clicking on the "Enrol Me" button. 

The Mock Exam Practice Course also includes a link to the list of modules with an exam, 

including details of which option each exam will use. Please see the section below on 

exam types. 

 

Exam options 

There are five exam options. Options 2-5 (Time-limited written or multiple choice exams) 

will usually only apply to modules which have restrictions due to Professional, Statutory 

and Regulatory Body (PSRB) requirements. A list of modules with details of which option 

each exam will use can be found on the Mock Exam Practice Course in Moodle (self-

enrolment required). 

 

Option 1: Standard written or multiple choice exam 

Students will have a 24 hour window in which to complete and submit the exam. The 24 

hour window for completion is to accommodate technical issues, international time 

differences and permitted extra time/rest breaks. 

https://www.brookes.ac.uk/students/exams/changes-to-2019-20-exams/
https://www.brookes.ac.uk/students/exams/changes-to-2019-20-exams/
https://www.brookes.ac.uk/students/exams/student-faqs/#covid19
https://moodle.brookes.ac.uk/course/view.php?id=51088
https://moodle.brookes.ac.uk/course/view.php?id=51088
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Option 2: Time-limited written exam (10am start time) 

This option mainly relates to modules in the following subject areas: 

ACFI MATH SOFT 

COMP  MCEL STAT 

ENGR NETW TECM 

 

For these modules, your exam will start at 10am UK time (the time displayed in your 

Google Calendar), and you will have the stated exam length (usually 2 or 3 hours), plus an 

additional hour to account for any technical issues. If you are entitled to extra time or rest 

breaks as part of an approved Inclusive Support Plan (ISP), this will be added to the time 

you have to complete your exam.  

 

Option 3: Time-limited written exam (24 hour window) 

Students will have a 24 hour window in which to start the exam. Clicking to view the exam 

will start a timer which will determine the student's end time. The timer will allow students 

the stated exam length plus 1 hour to accommodate technical issues. Students with 

Inclusive Support Plans (ISPs) will have their Wellbeing-agreed extra time/rest breaks 

included. 

 

Option 4: Time-limited multiple choice exam (10am start time) 

This option mainly relates to modules in the following subject areas: 

ACFI MATH SOFT 

COMP  MCEL STAT 

ENGR NETW TECM 

 

For these modules, your exam will start at 10am UK time (the time displayed in your 

Google Calendar), and you will have the stated exam length (usually 2 or 3 hours), plus an 

additional hour to account for any technical issues. If you are entitled to extra time or rest 

breaks as part of an approved Inclusive Support Plan (ISP), this will be added to the time 

you have to complete your exam.  
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Option 5: Time-limited multiple choice exam (24 hour window) 

Students will have a 24 hour window in which to start the exam. Clicking to view the exam 

will start a timer which will determine the student's end time. The timer will allow students 

the stated exam length plus 1 hour to accommodate technical issues. Students with 

Inclusive Support Plans (ISPs) will have their Wellbeing-agreed extra time/rest breaks 

included. 

 

Accessing your online exam 

On the day of your exam, log in to the Moodle course for the module. The link to the paper 

and any additional materials will be made visible at 10am (UK time). If you have logged 

into Moodle before 10am, you will need to refresh your browser to be able to click the link 

and access your exam. 

The link to your exam may vary in appearance, depending on how your Module Leader 

has set up the Moodle page. If you are unable to locate the link to your exam, make sure 

you are on the main course page in Moodle, press Ctrl+F in your browser and search for 

“Exam”. 

The title of the link to the exam will include the length of time you have to complete the 

exam (e.g. “Exam 3 hours”). You will need to make sure that you have a way to check the 

time, as you will not be able to submit your answer sheet after the deadline. 

When the link becomes available, click on it. Follow the instructions to access your exam 

paper, additional materials and answer sheet templates. Make sure you read and 

understand all of the instructions, in particular the section on Academic Conduct. If you 

need to attach a blue card to your answer sheet, make sure you are familiar with how to do 

this. More information on blue cards can be found on the Wellbeing website. 

 

Answer sheet templates 

If your exam includes written answer questions, you will be able to download an answer 

sheet template to use. Templates are provided for Microsoft Word and Google Docs: 

MS Word template  Google Doc template (click the “Make a copy” button) 

https://www.brookes.ac.uk/students/wellbeing/dyslexia-spld/support/blue-marking-cards/
https://www.brookes.ac.uk/documents/students/exams/written-exam-answer-sheet/
https://docs.google.com/document/d/13wQRAFHYQGiP0KhQxubqF950sjyRLh-ICfIWqqxFcK4/copy
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If you prefer to hand write your answers, you are allowed to do this. You can then paste 

pictures of your handwritten answers into the answer sheet template.  

Please note, Turnitin will not accept any submissions with fewer than 20 words of 

typed text. If you try to submit a document without 20 words of typed text, Turnitin will 

reject it. Therefore it is recommended that you do not delete the text on the first page of 

the template you are using. There are instructions at the end of this document on including 

pictures, graphs, formulae and diagrams in your answer sheet. 

 

Turnitin submission for online exams (Options 1 and 2) 

 

Important: If you used Apple Pages on a Mac to write your submission, you must export 

to PDF before you submit. Turnitin does not accept *.pages files. 

 

1. Make sure that the document you want to submit includes at least 20 words of typed 

text. If you take photographs of your work and insert these into your answer 

sheet, without including at least 20 words of text, Turnitin will reject the file. 

2. Make sure that the file you want to submit is in Microsoft Word or PDF format. 

3. Make sure the file is 100MB or less in size. 

4. Save the file you want to submit and close the software (e.g. Microsoft Word) you 

used to write your submission on your computer. 

5. Use a stable, secure internet connection. 

6. Start the submission as early as possible. 

7. If you experience any problems, try a using different browser and/or device. 

8. To submit your file, click on the link to the exam as described in the “Accessing your 

online exam” section above. 

9. Click the Submit Paper icon at the bottom of the page. 
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10. Enter a Submission Title. 

 

 

11. Drag and drop your file into the submission area. 

 

 

12. Check the box to confirm that this submission is your own work. 

 

 

13. Click Add submission. 

 

 

14. After a few seconds, you will see the message “Your submission has been 

successfully uploaded”. Click Close (top right). 
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15. The Moodle page will refresh and the Turnitin Paper ID will appear next to the 

submission title. 

 

 

Blue card submissions 

Students who are eligible for a blue card submission need to follow the instructions here: 

Blue marking cards. 

 

How do I know that I successfully submitted? 

Check your Brookes Gmail inbox for a digital receipt of your submission from Turnitin. You 

must keep this email, as this provides proof that you made the submission.  

If a Turnitin Paper ID has appeared in your Moodle page and you have received the digital 

receipt (which also includes the Turnitin Paper ID) of your submission in your Brookes 

Gmail inbox, then your submission has been successfully uploaded to Turnitin. 

Alternatively, check in Moodle that a ‘View Digital Receipt’ link has appeared on the left of 

the submission title, as shown: 

 

  

https://www.brookes.ac.uk/students/wellbeing/dyslexia-spld/support/blue-marking-cards/
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Converting your submission file to PDF 

 

Convert to PDF in Microsoft Word (Windows) 

1. Click the File tab 

2. Click Save As. To see the Save As dialog box, you may need to choose a location to 

save to by clicking Browse. 

3. In the File Name box, enter a name for the file, if you haven't already. 

4. In the Save as type list, click PDF (*.pdf). If you want the file to open in the selected 

format after saving, select the Open file after publishing check box. 

5. Click Save. 

 

Convert to PDF in Microsoft Word (Mac) 

1. Click File. 

2. Click Save As. 

3. Click File Format towards the bottom of the window. 

4. Select PDF from the list of available file formats. 

5. Give your file a name, if it doesn't already have one. 

6. Click Export. 

 

Convert to PDF in Apple Pages (Mac) 

1. Click File (from the menu at the top of your screen). 

2. Choose Export to. 

3. Select PDF. 

 

Convert to PDF in Apple Pages on iPhone/iPad (iOS) 

1. Tap More  

2. Tap Export. 

3. Choose and tap PDF. 
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Convert to PDF in Microsoft Word on iPhone/iPad (iOS) 

To export your Word document or Excel workbook to PDF format on iOS: 

1. Tap the File icon (at the top left). 

2. Choose and tap Export. 

3. Choose and tap PDF. 
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Guidance on the University’s Academic Conduct Regulations 

There are many different ways that work can be assessed as an alternative to traditional 

invigilated examinations. For example, you might be given an essay title where you have 

to write the essay and submit it within a few days, or you might be given a 24 hour period 

in which you have to spend a specific number of hours completing an online exam.  

 

As a general rule, the University’s academic conduct regulations will always apply and 

your work will normally be put through Turnitin, so unless you have specifically been told 

about a variation to the conduct rules, follow the below guidance to keep within the 

regulations: 

 

You should: 

● always write your answers yourself, in your own words. Upgrade have some tips 

about paraphrasing; 

● if you need to use other people’s words, figures, pictures or ideas, (e.g from a book 

or another source,) for part of your examination answer, properly reference them 

using the correct referencing style. Upgrade have some tips about avoiding 

plagiarism; 

● work on your own without getting help from anyone else; 

● submit your own work via Moodle; 

 

You should not: 

● help other people complete their exam or share your exam with anyone else – this 

is a breach of the conduct regulations and you would be penalised; 

● make contact with anyone else taking the same exam as you during the exam 

period – this may look like an attempt to cheat. If you have an issue with the exam 

paper itself, contact the Exams Team, the Module Leader, or read the “Technical 

Issues” guidance on the Covid-19 Exams webpage; 

https://www.brookes.ac.uk/students/upgrade/online-resources/paraphrasing/
https://www.brookes.ac.uk/students/upgrade/online-resources/paraphrasing/
https://www.brookes.ac.uk/students/upgrade/online-resources/plagiarism/
https://www.brookes.ac.uk/students/upgrade/online-resources/plagiarism/
https://www.brookes.ac.uk/students/exams/changes-to-2019-20-exams/
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● copy previous work you have submitted for other assignments or exams, this will be 

deemed duplication and is a breach of the regulations; 

● gain access to any unauthorised material relating to the assessment before the 

information is released; 

● take copies or images of questions and upload them for the purposes of sharing 

with others who may not have taken the exam yet; 

● use custom writing services. 

 

If the assessment is an online exam, check what information you are allowed to consult 

during the exam period, e.g. written or printed material, or electronic information.  

The full set of regulations can be found at the below link. All potential breaches of the 

Academic Misconduct Regulations will be investigated and may be subject to a penalty. 

 

Variations 

Sometimes, module teams will decide that one or more of the regulations will not be 

applied to the specific assessment that you have to do. If they do, this will be 

communicated to you in writing in advance, and the information should be available 

on the module’s Moodle page. For example, you might be allowed to consult specific 

resources such as books or websites during the exam, or you might be permitted to 

discuss other people’s ideas without including an in-text citation and reference list. 

We understand that it can be confusing to know which academic conduct rules apply in 

relation to each format. This guidance is intended to help. 

The academic conduct regulations are designed to ensure fairness for all students, so any 

breaches of them are treated very seriously and will undergo an investigation just like a 

breach for any other assessment. Therefore, if you are not sure whether you’ll be allowed 

to do something, you should check the information on the Moodle course page, and ask 

your Module Leader for clarification.  

  

https://www.brookes.ac.uk/regulations/current/appeals-complaints-and-conduct/c1-1/c1-1-4/
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How to include photographs or pictures in your answer 

 

Google Photos 

Your Google@Brookes account includes access to Google Photos, which can be 

configured to automatically sync photographs taken with a mobile phone to your Google 

account. To set this up, you need to have the Google Photos app installed on your phone 

through the Play Store (for Android) or the App Store (for iPhone). 

Once you have installed Google Photos, you need to set it to sync photographs to your 

Google@Brookes account. Once you have done this, you can access and download your 

photographs via the Google Apps menu: 

 

  

https://support.google.com/photos/answer/6193313?co=GENIE.Platform%3DAndroid&hl=en
https://support.google.com/photos/answer/6193313?co=GENIE.Platform%3DAndroid&hl=en
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Snipping Tool 

If the picture you want to include is available on your PC, you can use the Snipping Tool 

to take a screenshot, and then following the instructions below on how to insert it into a 

Word document or Google Doc. The Snipping Tool can be found in the Windows 

Accessories folder in the Start menu: 

 

 

Navigate to the window you want to take a screenshot of, then open the Snipping Tool and 

click New: 
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Drag the cursor around the area of the screen you want to capture. You can then copy and 

paste the screenshot into your answer sheet. 

 

Microsoft Word 

Select the location in the document where you want to insert a photo or picture. Click on 

the Insert tab, and then on Pictures: 

 

 

Navigate to the folder on your PC where your photos/pictures are saved, and select the 

picture you want to insert, then click Insert: 
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Google Docs 

Select the location in the document where you want to insert a photo or picture. Click on 

the Insert tab, and then on Image: 

 

 

Then select where the picture is stored (e.g. Upload from computer if it is on your PC, or 

Photos if it is in your Google Photos), click on the picture you want to insert and click 

Insert. 
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How to include diagrams in your answer 

The simplest method for including diagrams in your answer would be to hand draw them 

and then take a photograph, which can be inserted into your answer paper – see the 

instructions above on including photographs and pictures. 

 

Microsoft Word 

You can create graphics using the SmartArt option within Microsoft Word. Select the 

location in the document where you want to insert the graphic. Click on the Insert tab, and 

then on SmartArt: 

 

 

Select the type of SmartArt graphic you want to include, and click OK: 
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Edit the fields to create the graphic you want to include: 

 

 

Google Docs 

Select the location in the document where you want to insert a diagram. Click on the 

Insert tab, and then on Drawing: 

 

 

Click New, and a dialog box will appear where you can create a graphic using Shapes and 

Connectors. Click Save and Close to insert the graphic into your answer sheet: 
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How to include graphs in your answer 

The simplest method for including graphs in your answer would be to hand draw them and 

then take a photograph, which can be inserted into your answer paper – see the 

instructions above on including photographs and pictures. 

There are also a number of websites that provide electronic graph paper, such as print-

graph-paper.com/virtual-graph-paper (straight line graphs only) and fillable-grid-

online.pdffiller.com/. 

 

Microsoft Word 

You can create graphs within Microsoft Word. Select the location in the document where 

you want to insert the chart. Click on the Insert tab, and then on Chart: 

 

 

Select the type of graph you want to include, and click OK: 

  

http://print-graph-paper.com/virtual-graph-paper
http://print-graph-paper.com/virtual-graph-paper
https://fillable-grid-online.pdffiller.com/
https://fillable-grid-online.pdffiller.com/
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Edit the fields to create the graph you want to include: 

 

 

Google Docs 

Select the location in the document where you want to insert a graph. Click on the Insert 

tab, and then on Chart, then select the type of graph you want to include: 
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To edit the fields to create the graph you want to include, click to select the graph and then 

click the Link symbol in the top right corner and select Open source: 

 

 

This will open a Google Sheet where you can amend values and other information: 
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How to type in Japanese 

Microsoft Word 

Please see these instructions on how to type in Japanese in Microsoft Word. There are 

also instructions on how to install a Japanese keyboard. 

 

Google Docs 

To access the Japanese Input Method Editor in Google Docs, follow the instructions 

below. 

1. Go to myaccount.google.com/.  

2. Go to Data and personalisation > General preferences for the web.  

3. Click on Input Tools, and then click Add Language.  

4. Add the languages that you need and select Input Method Editor. 

5. Scroll down and under Options tick the box for Keep dictionary synchronised 

between Google services. 

 

In Google Docs, go to File > Language and select the language you need. Once you have 

it set up under Input Tools in myaccount.google.com/ as outlined above, you should be 

able to easily switch between languages, including the dictionary. 

  

https://www.tofugu.com/japanese/how-to-type-in-japanese/
https://www.tofugu.com/japanese/how-to-install-japanese-keyboard/
https://myaccount.google.com/
https://myaccount.google.com/
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How to type in other languages that use accents (e.g. French 

or Spanish) 

Microsoft Word 

Select the location in the document where you want to insert the accented letter. Click on 

the Insert tab, and then on Symbol: 

 

 

Click on More Symbols: 

 

 

Select the correct font, then select the accented letter you want to use and click Insert: 
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You can keep the Symbol menu open and continue typing as normal, to save having to 

reopen it every time you want to insert an accented letter. 

 

Google Docs 

Select the location in the document where you want to insert the accented letter. Click on 

the Insert tab, and then on Special characters: 

 

 

The Insert special characters dialog will appear – click to select the accented letter you 

want to insert into your document: 

 

 

You can keep the Special Characters menu open and continue typing as normal, to save 

having to reopen it every time you want to insert an accented letter.  
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How to include mathematical formulae and calculations 

The simplest method for including mathematical formulae and calculations in your answer 

would be to hand write them and then take a photograph, which can be inserted into your 

answer paper – see the instructions above on including photographs and pictures. 

 

Microsoft Word 

To type an equation in Word, select the location in the document where you want to insert 

the equation. Click on the Insert tab, and then on Equation: 

 

 

Use the Equation Tools Design menu to create your equation: 

 

 

Google Docs 

To type an equation in Google Docs, select the location in the document where you want 

to insert the equation. Click on the Insert tab, and then on Equation: 
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Use the Equation toolbar to create your equation: 

 

 


